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introducción a la impresión inalámbrica 
Bluetooth
Las impresoras HP Deskjet 995c series y HP Deskjet 995ck series admiten la 
impresión inalámbrica BlueTooth.

La función de Bluetooth le permite imprimir sin la necesidad de tener una conexión 
por cable entre un dispositivo inalámbrico con tecnología Bluetooth y la impresora.

Para obtener instrucciones acerca de la impresión inalámbrica Bluetooth, 
seleccione el tema adecuado:

• impresión desde un equipo de escritorio o un ordenador portátil
• impresión desde un dispositivo de bolsillo
• impresión desde otros dispositivos Bluetooth

actualizaciones
Dado que la comunicación inalámbrica Bluetooth es una tecnología en constante 
evolución, la información contenida en este documento está sujeta a cambios.

A fin de poder proporcionar la información más actualizada posible, este 
documento será revisado y publicado en la página Web de HP. 
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impresión desde un equipo de escritorio o un 
ordenador portátil
Para utilizar la impresora, el ordenador debe admitir tecnología inalámbrica 
Bluetooth. 

Si su ordenador cuenta con un dispositivo de transmisión por ondas de radio, 
consulte la documentación que se adjunta con él referente a la función inalámbrica 
Bluetooth.

Si su ordenador no cuenta con este dispositivo, deberá utilizar una PC card 
de Bluetooth o un adaptador para poder utilizar la tecnología Bluetooth.

Existen varios dispositivos para hacer que su ordenador admita la tecnología 
inalámbrica Bluetooth. Este documento contiene instrucciones para los siguientes:

• PC card inalámbrica Bluetooth de 3Com
• adaptador USB Bluetooth inalámbrico de 3Com
• Microsoft Optical Desktop para Bluetooth (HCRP)

Si utiliza un dispositivo inalámbrico Bluetooth que no sea de 3Com, consulte la 
documentación que se incluye con el dispositivo o póngase en contacto con el 
fabricante para obtener instrucciones sobre la impresión.
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PC card inalámbrica Bluetooth de 3Com 
Las instrucciones de impresión que se indican en esta sección se refieren a los 
ordenadores equipados con una PC card inalámbrica Bluetooth de 3Com.

requisitos
Antes de poder imprimir, necesitará un ordenador y una PC Card inalámbrica 
Bluetooth de 3Com.

Visite la página Web de 3Com en: www.3com.com.

configuración e impresión
Siga estas instrucciones para configurar e imprimir en una conexión inalámbrica 
Bluetooth con la PC Card inalámbrica Bluetooth de 3Com:

1. Instale la PC Card inalámbrica Bluetooth de 3Com en el ordenador.

2. Imprima un archivo. 

instalación de una PC card inalámbrica Bluetooth de 3Com
Para instalar una PC card inalámbrica Bluetooth de 3Com en un ordenador portátil, 
consulte las instrucciones en la documentación de la PC card.

Si utiliza una PC card inalámbrica Bluetooth que no es de 3Com, consulte las 
instrucciones en la documentación de la PC card o póngase en contacto con el 
fabricante para obtener instrucciones para la impresión.

http://www.3com.com
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instrucciones de impresión
1. Abra el archivo que desea imprimir.

2. Seleccione File > Print (Archivo/Imprimir).
Aparece el cuadro de diálogo Print (Imprimir).

3. Haga clic en Print (Imprimir). 
Aparece el cuadro de diálogo Select Remote Device 
(Seleccionar dispositivo remoto).

4. Seleccione la impresora.
La impresora aparecerá identificada por su nombre de dispositivo Bluetooth 
(consulte la página 63).
Para utilizar siempre esta impresora específica, haga clic en Always use for this 
connection (Utilizar siempre para esta conexión). 

5. Haga clic en el botón Connect (Conectar).
El LED de Bluetooth parpadea cuando el ordenador portátil establece una 
conexión inalámbrica Bluetooth con la impresora. 

Una vez que el ordenador portátil haya enviado el archivo a la impresora, 
aquél se desconectará de la impresora y el LED de Bluetooth dejará de 
parpadear.
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adaptador USB Bluetooth inalámbrico de 3Com
Las instrucciones de impresión que se indican en esta sección se refieren a los 
ordenadores equipados con un adaptador USB Bluetooth inalámbrico de 3Com.

requisitos
Antes de poder imprimir, necesitará un ordenador y un adaptador USB Bluetooth 
inalámbrico de 3Com.

Visite la página Web de 3Com en: www.3com.com.

configuración e impresión
Siga estas instrucciones para configurar e imprimir con el adaptador USB Bluetooth 
inalámbrico de 3Com mediante una conexión inalámbrica Bluetooth:

1. Instale el adaptador USB Bluetooth inalámbrico de 3Com en el ordenador.

2. Imprima un archivo. 

instalación de un adaptador USB Bluetooth de 3Com

Para instalar un adaptador USB Bluetooth inalámbrico de 3Com en un equipo de 
escritorio o un ordenador portátil, consulte la documentación que se incluye con el 
adaptador.

Si utiliza un adaptador Bluetooth inalámbrico que no sea de 3Com, consulte la 
documentación que se incluye con el adaptador o póngase en contacto con el 
fabricante para obtener instrucciones para la impresión.

http://www.3com.com
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instrucciones de impresión
1. Abra el archivo que desea imprimir.

2. Seleccione File (Archivo) > Print (Imprimir).
Aparece el cuadro de diálogo Print (Imprimir).

3. Haga clic en Print (Imprimir). 
Aparece el cuadro de diálogo Select Remote Device 
(Seleccionar dispositivo remoto).

4. Seleccione la impresora.
La impresora aparecerá identificada por su nombre de dispositivo Bluetooth 
(consulte la página 63).
Para utilizar siempre esta impresora específica, haga clic en Always use for this 
connection (Utilizar siempre para esta conexión). 

5. Haga clic en el botón Connect (Conectar).
El LED de Bluetooth parpadea cuando el ordenador portátil establece una 
conexión inalámbrica Bluetooth con la impresora. 

Una vez que el ordenador portátil haya enviado el archivo a la impresora, 
aquél se desconectará de la impresora y el LED de Bluetooth dejará de 
parpadear.
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Microsoft Optical Desktop para Bluetooth (HCRP)
Las instrucciones de impresión que se incluyen en esta sección se refieren 
a los ordenadores que utilizan Microsoft Optical Desktop para Bluetooth 
(teclado, ratón y dongle) y el sistema operativo Microsoft Windows XP.

Microsoft Optical Desktop para Bluetooth utiliza el Hardcopy Cable Replacement 
Profile (HCRP, Perfil de recambio de cable de impresión), que permite que su 
ordenador se comunique con la impresora como si estuvieran comunicados por 
un cable.

requisitos
Antes de imprimir necesitará lo siguiente:

• Microsoft Optical Desktop para Bluetooth
• cable USB
• Windows XP

Antena Bluetooth de Microsoft 
Optical Desktop para Bluetooth

configuración e impresión
Siga estas instrucciones para configurar e imprimir con Microsoft Optical Desktop 
para Bluetooth y una conexión HCRP:

1. Instale Microsoft Optical Desktop para Windows.

2. Actualice el firmware y el software de la impresora.

3. Conecte la impresora con Bluetooth y HCRP.

4. Imprima un archivo.
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instale Microsoft Optical Desktop para Bluetooth
Para obtener las instrucciones de instalación, consulte la documentación que se 
adjunta con Microsoft Optical Desktop para Bluetooth.

Durante la instalación de Microsoft Optical Desktop para Bluetooth, el sistema 
operativo Windows XP de su ordenador se actualizará con un parche de Microsoft 
para permitir la impresión HCRP.

actualización del firmware y del controlador de la impresora
HP actualiza de forma regular el firmware y el controlador de la impresora, ya que 
las comunicaciones inalámbricas Bluetooth son parte de una tecnología de reciente 
desarrollo.

El firmware es el software interno de la impresora. El controlador de la impresora 
es el software que se utiliza para manejar la impresora desde el ordenador.

La actualización del firmware y del controlador de la impresora es un proceso 
que consta de tres pasos:

1. Descarga del firmware y del controlador de impresora más recientes.

2. Instalación del firmware en la impresora.

3. Instalación del controlador de la impresora en su ordenador.

descarga del firmware y del software más recientes

En la red está disponible el firmware y el software más recientes.

1. Consulte www.hp.com/support/bluetooth.

2. Seleccione el idioma adecuado.

3. Haga clic en descarga de controladores y software en la lista de la izquierda 
de la página.

4. Haga clic en Microsoft Windows XP.

5. Descargue y guarde en su ordenador las siguientes actualizaciones:
• HP Deskjet 995c HCRP firmware update (Actualización de firmware HCRP de la 

HP Deskjet 995c) 
• HP Deskjet 995c HCRP printer driver for Windows XP (controlador HCRP de la 

HP Deskjet 995c para Windows XP)
Tras guardar cada actualización, copie el nombre de archivo y ubicación 
de la actualización en una hoja de papel.

http://www.hp.com/go/support/bluetooth
http://www.hp.com/support/bluetooth
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instalación del firmware de la hp deskjet 995c series
Para instalar el firmware más reciente, haga lo siguiente:

1. Ubique la actualización del firmware HCRP de la hp deskjet 995c en 
su ordenador.

2. Haga doble clic en el archivo de actualización de firmware HCRP de 
la hp deskjet 995c.

3. Siga las instrucciones que aparecerán en la pantalla para actualizar el 
firmware de la impresora.

instalación del controlador de impresora más reciente
Para actualizar el controlador de impresora de la hp deskjet 995c series, 
haga lo siguiente:

1. Ubique la actualización del controlador HCRP de la hp deskjet 995c 
en su ordenador.

2. Haga doble clic en la actualización del controlador HCRP de la 
hp deskjet 995c.

3. Siga las instrucciones que aparecerán en la pantalla para actualizar 
el controlador de la impresora hp deskjet 995c.

Ejecute la actualización de firmware desde su unidad de disco duro 
exclusivamente. El programa de actualización no se podrá ejecutar 
desde el CD-ROM.
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conexión a la impresora con Bluetooth y HCRP
Para conectar la impresora al ordenador mediante Bluetooth y HCRP, asegúrese 
de que éste está conectado a Microsoft Optical Desktop para dongle Bluetooth y, 
a continuación, haga lo siguiente:

1. Para imprimir una página de configuración de Bluetooth, mantenga pulsado 
el botón Cancel (X) (Cancelar) durante cuatro segundos.

La página de configuración de Bluetooth contiene información que le será de 
utilidad cuando lleve a cabo la conexión a la impresora.

2. Haga clic en Home (Inicio) > Control Panel (Panel de control) y, a continuación, 
elija una de las siguientes opciones:

Category View (Vista de categoría) Classic View (Vista clásica)

Haga doble clic en el icono Wireless 
Link (Vínculo inalámbrico).

Haga clic en Printers and other 
Hardware (Impresoras y otro hardware) 
y, a continuación, haga clic en el icono 
Wireless Link (Vínculo inalámbrico).
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3. Haga clic en la ficha Bluetooth.

4. Haga clic en el botón Add (Agregar). 
Aparecerá el Bluetooth Connection Wizard (Asistente para conexión Bluetooth).
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5. Haga clic en Next (Siguiente).
El ordenador busca los dispositivos de tecnología inalámbrica Bluetooth que 
existan y los muestra en la lista de resultados.

si sucede esto... haga esto...

Hay más de una 
impresora hp deskjet 
995c en la lista

Busque el nombre del dispositivo en la página 
de configuración de Bluetooth. 
Haga coincidir el nombre del dispositivo de la 
página de configuración de Bluetooth con el del 
asistente de conexión.

La impresora no 
aparece

Haga clic en Refresh (Actualizar) una vez. 
Si sigue sin ver la impresora, consulte resolución 
de problemas.
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6. Seleccione la impresora en la lista y, a continuación, haga clic en Next 
(Siguiente).
Aparecerá la pantalla Authenticate the device? (¿Autenticar el dispositivo?).

7. Busque el elemento de línea de Authentication Required (Autenticación) en la 
página de configuración de Bluetooth y, a continuación, elija una de las 
siguientes opciones:

si en la línea de Authentication 
Required (Autenticación) se lee...

entonces...

Authentication = 0 (Autenticación = 0)
Authentication Off (Autenticación 
desactivada)

Haga clic en No y, a continuación, 
en Next (Siguiente).

Authentication = 1 (Autenticación = 1)
Authentication On (Autenticación 
activada)

Haga clic en Yes (Sí) y, a 
continuación, en Next (Siguiente). 
Se le solicitará el código PIN de la 
impresora. Introduzca el código PIN.

La configuración de la autenticación debe coincidir con la de la 
impresora hp deskjet 995c series printer. Si elige No, y ya ha 
utilizado la caja de herramientas de la hp deskjet 995c para 
modificar los ajustes necesarios para la codificación de la impresora, 
no podrá imprimir. Deberá restablecer los valores de fábrica. 

Para más información sobre cómo modificar las funciones 
inalámbricas de la impresora, consulte cambio del dispositivo 
inalámbrico de la impresora.
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8. Haga clic en la casilla de verificación Printing (HCRP) [Impresión (HCRP)].

9. Haga clic en Next (Siguiente) y, a continuación, en Finish (Finalizar).

Aparecerá el icono de la impresora hp deskjet 995c series en la lista de 
dispositivos. Si esto no sucediera, consulte la entrada de resolución de 
problemas tras la instalación HCRP, el icono de la impresora no aparece en la 
lista My Printers (Mis impresoras).

impresión de un archivo
Para verificar que la comunicación entre la impresora y el ordenador 
es satisfactoria:

1. Haga clic en Start (Inicio)> Printers and Faxes (Impresoras y faxes). 

2. Haga clic con el botón derecho del ratón en el icono de la impresora y, 
a continuación, en Set As Default Printer (Establecer como impresora 
predeterminada). 
Si hay una marca de verificación junto al icono, la impresora se ha 
establecido como predeterminada. 

3. Abra un documento existente.

4. Seleccione File (Archivo)> Print (Imprimir).
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impresión desde un dispositivo de bolsillo
Están saliendo al mercado muchos dispositivos de bolsillo compatibles con 
tecnología inalámbrica Bluetooth.

Este documento contiene instrucciones para los siguientes:

• hp Jornada 500 series y hp Jornada 700 series
• Compaq iPAQ Pocket PC
• dispositivo de bolsillo Palm m500 series

Si utiliza un dispositivo de bolsillo Bluetooth que no sea de 3Com, consulte la 
documentación que se incluye con el dispositivo o póngase en contacto con el 
fabricante para obtener instrucciones para la impresión.



16

hp Jornada 500 series y hp Jornada 700 series
Si desea obtener ayuda al imprimir mediante una conexión Bluetooth con el 
ordenador de bolsillo HP Jornada, seleccione su modelo de Jornada.

HP Jornada 500 series  HP Jornada 700 series
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hp jornada 500 series
El HP Jornada 500 series PocketPC admite la impresión inalámbrica Bluetooth:

requisitos
Antes de imprimir, necesitará lo siguiente:

• Una de las siguientes tarjetas Bluetooth:
• Una tarjeta Bluetooth de Socket Communications y su software. Visite el sitio 

Web de Socket Communications en: www.socketcom.com.
—o—

• Cualquier tarjeta Bluetooth de AnyCom, Inc. y su software. Visite el sitio 
Web de AnyCom en: www.anycom.com.

• Una aplicación de impresión de otro fabricante para HP Jornada 500 series. 
Visite el sitio Web de FieldSoftware Products en: 
www.fieldsoftware.com/PrintPocketCE.htm

configuración e impresión
Siga estas instrucciones para configurar e imprimir con la HP Jornada 500 series:

1. Instale una tarjeta Bluetooth de Socket o AnyCom y su software.

2. Instale una aplicación de impresión de otro fabricante.

3. Descubra la impresora.

4. Imprima un archivo.

http://www.socketcom.com
http://www.anycom.com
http://www.fieldsoftware.com/PrintPocketCE.htm
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instalación de una tarjeta Bluetooth de Socket o Anycom
Las instrucciones de instalación pueden variar según el fabricante. Siga las 
instrucciones de instalación recibidas junto con su tarjeta Bluetooth; en caso 
de no haberlas recibido, siga las que se indican a continuación:

1. Coloque el ordenador de bolsillo Jornada en su soporte.

2. Inserte el CD con el software de Bluetooth en la unidad de CD-ROM 
del ordenador.

3. Siga las instrucciones que aparecen en pantalla para instalar el software 
de Bluetooth.

4. Una vez instalado el software, retire el ordenador de bolsillo Jornada 
de su soporte.

5. Pulse el botón Reset (Reiniciar).
Espere hasta que se reinicie el ordenador de bolsillo y vuelva a pulsar 
el botón Reset (Reiniciar). Este botón se encuentra en la parte posterior del 
Jornada 500.

Advertencia Si no se reinicia dos veces después de la instalación de 
una tarjeta Bluetooth de Anycom, Jornada 500 series no imprimirá 
correctamente mediante conexión inalámbrica Bluetooth.

6. Inserte la tarjeta Bluetooth en la ranura de expansión.
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instalación de la aplicación de impresión de otro fabricante
Los ordenadores de bolsillo, como el HP Jornada 500 series, requieren una 
aplicación de impresión de otro fabricante, como por ejemplo, PrintPocketCE. 

PrintPocketCE puede obtenerse en: www.fieldsoftware.com/PrintPocketCE.htm

descubrimiento de la impresora
Para que el ordenador hp jornada pueda imprimir, debe descubrir la impresora. 
Consulte descubrimiento de dispositivos Bluetooth en la página 62.

Para instrucciones sobre el descubrimiento, seleccione su tarjeta Bluetooth:

• Tarjeta Bluetooth de Socket
• Tarjeta Bluetooth de AnyCom

Las instrucciones de los productos de otros fabricantes se 
proporcionan para uso informativo exclusivamente. HP no admite 
estos productos y no puede garantizar la precisión de las 
instrucciones. Póngase en contacto con el fabricante del producto 
si desea obtener información adicional.

http://www.fieldsoftware.com/PrintPocketCE.htm
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tarjeta Bluetooth de Socket para HP Jornada 500 series

Vaya al escritorio del HP Jornada y siga estos pasos para descubrir la impresora:
1. Haga clic en el icono Bluetooth de la parte inferior de la pantalla.
2. Haga clic en Advanced Features > Bluetooth Devices (Funciones avanzadas/

Dispositivos Bluetooth).
Aparecerá la pantalla de dispositivos Bluetooth.

3. Haga clic en Tools > Device Discovery (Herramientas/Descubrimiento 
de dispositivos)
Aparecerá el Asistente para descubrimiento de dispositivos Bluetooth.

4. Haga clic en Next (Siguiente).
5. Haga clic en Any Bluetooth Device (Cualquier dispositivo Bluetooth) y luego 

en Next (Siguiente).
El Jornada buscará todos los dispositivos de tecnología inalámbrica Bluetooth 
que estén dentro del radio de alcance y mostrará el nombre de dispositivo 
Bluetooth (consulte la página 63) de todos los dispositivos que descubra.

6. Haga clic en la casilla de verificación que aparece junto al del nombre del 
dispositivo Bluetooth de la impresora, y, a continuación, en Next (Siguiente).

7. Cuando aparezca la ventana Congratulations (Enhorabuena), haga clic en 
Finish (Terminar).
El nombre del dispositivo Bluetooth de la impresora aparecerá junto a un icono 
de impresora en la carpeta BT Devices (Dispositivos BT).

8. Haga clic en Tools > My Favorite (Herramientas/Mi favorito).
9. Haga clic en la flecha desplegable My Favorite Device (Mi dispositivo favorito) 

para ver una lista de impresoras.
10. Seleccione la impresora y, a continuación, haga clic en OK (Aceptar).
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tarjeta Bluetooth de AnyCom para HP Jornada 500 series

Vaya al escritorio del HP Jornada y siga estos pasos para descubrir la impresora:

1. Haga clic en Today > Start > Programs > Bluetooth Wizard (Hoy/Inicio/
Programas/Asistente para Bluetooth).
Aparecerá la pantalla del Asistente para Bluetooth.

2. Haga clic en Serial Port Connection (Conexión por puerto serie).

3. Haga clic en Next (Siguiente).

4. Seleccione un puerto COM local disponible y haga clic en Next (Siguiente).
El Jornada buscará todos los dispositivos de tecnología inalámbrica Bluetooth 
que estén dentro del radio de alcance y mostrará el nombre de dispositivo 
Bluetooth (consulte la página 63) de todos los dispositivos que descubra. Si la 
impresora no aparece, haga clic en Search Again (Buscar de nuevo).

5. Seleccione la impresora y haga clic en Next (Siguiente).
La tarjeta Bluetooth asociará el puerto COM a la impresora.

6. Haga clic en Finish (Terminar) y luego en Exit (Salir).
Jornada se comunicará con la impresora a través del puerto COM seleccionado 
en el paso 4. Tome nota del puerto COM seleccionado para su uso en el futuro.

Si no aparece un icono del Asistente para Bluetooth, haga clic en 
File Explorer > My Device > Program Files > [nombre de la tarjeta 
Bluetooth] Bluetooth Card > Bluetooth Wizard (Explorador de archivos / 
Mi dispositivo / Archivos de programa /Tarjeta Bluetooth [nombre de 
tarjeta] / Asistente para Bluetooth).
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impresión de un archivo mediante HP Jornada 500 series
aplicaciones de otros fabricantes

Las instrucciones de impresión con el HP Jornada 500 pueden variar según la 
aplicación de impresión de otro fabricante que se utilice. Para ver las instrucciones 
de impresión, consulte la documentación que recibió junto con la aplicación de otro 
fabricante.

búsqueda del puerto COM de Bluetooth 

Cuando instala una tarjeta Bluetooth en un ordenador HP Jornada, éste la asignará 
a uno de los puertos COM disponibles. Algunas aplicaciones de impresión 
requieren que el usuario conozca el puerto COM para la tarjeta Bluetooth.

Para encontrar el puerto COM de Bluetooth:

1. Abra el archivo que desea imprimir.

2. Seleccione los puertos COM disponibles, uno a uno, hasta que se imprima 
el archivo.

3. Anote el puerto COM para un uso posterior.
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hp Jornada 700 series
HP Jornada 700 series PocketPC admite la impresión inalámbrica Bluetooth:

requisitos
Antes de imprimir necesitará una tarjeta Bluetooth de Socket Communications y su 
software. Visite el sitio Web de Socket Communications en: www.socketcom.com.

configuración e impresión
Siga estas instrucciones para configurar e imprimir con HP Jornada 700 series:

1. Instale una tarjeta Bluetooth de Socket y su software.

2. Descubra la impresora.

3. Imprima un archivo.

http://www.socketcom.com
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instalación de una tarjeta Bluetooth de Socket 
Las instrucciones de instalación pueden variar según el fabricante. Siga las 
instrucciones de instalación recibidas junto con su tarjeta Bluetooth; en caso 
de no haberlas recibido, siga las que se indican a continuación:

1. Coloque el ordenador de bolsillo Jornada en su soporte.

2. Inserte el CD con el software de Bluetooth en la unidad de CD-ROM 
del ordenador.

3. Siga las instrucciones que aparecen en pantalla para instalar el software 
de Bluetooth.

4. Una vez instalado el software, retire el ordenador de bolsillo Jornada de 
su soporte.

5. Pulse el botón Reset (Reiniciar) una vez con el lápiz. 
Este botón se encuentra en el lado izquierdo del teclado.

6. Inserte la tarjeta Bluetooth en el puerto o en la ranura de expansión.

puerto de expansión ranura de expansión con 
adaptador de tarjeta de PC
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descubrimiento de la impresora
Vaya al escritorio del HP Jornada y siga estos pasos para descubrir la impresora:
1. Haga clic en el icono Bluetooth de la parte inferior de la pantalla.
2. Haga clic en Advanced Features > Bluetooth Devices (Funciones avanzadas/

Dispositivos Bluetooth).
Aparecerá la pantalla de dispositivos Bluetooth.

3. Haga clic en Tools > Device Discovery (Herramientas/Descubrimiento de 
dispositivos)
Aparecerá el asistente para descubrimiento de dispositivos Bluetooth.

4. Haga clic en Next (Siguiente).
5. Haga clic en Any Bluetooth Device (Cualquier dispositivo Bluetooth) y luego en 

Next (Siguiente).
Jornada buscará todos los dispositivos de tecnología inalámbrica Bluetooth que 
estén dentro del radio de alcance y mostrará el nombre de dispositivo Bluetooth 
(consulte la página 63) de todos los dispositivos que descubra.

6. Haga clic en la casilla de verificación que aparece junto al del nombre del 
dispositivo Bluetooth de la impresora, y luego en Next (Siguiente).

7. Cuando aparezca la ventana Congratulations (Enhorabuena), haga clic en 
Finish (Terminar).
El nombre del dispositivo Bluetooth de la impresora aparecerá junto a un icono 
de impresora en la carpeta BT Devices (Dispositivos BT).

8. Haga clic en Tools > My Favorite (Herramientas/Mi favorito).
9. Haga clic en la flecha desplegable My Favorite Device (Mi dispositivo favorito) 

para ver una lista de impresoras.
10. Seleccione la impresora y, a continuación, haga clic en OK (Aceptar).
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impresión de un archivo con el HP Jornada 700 series

Siga estos pasos para imprimir mediante una conexión inalámbrica Bluetooth:

1. Inserte la tarjeta Bluetooth de Socket en la ranura de expansión del ordenador 
Hp Jornada.

2. Abra el archivo que desea imprimir.

3. Haga clic en File > Print (Archivo/Imprimir).
Aparece el cuadro de diálogo Print (Imprimir).

4. Seleccione PCL Inkjet en el menú Printer (Impresora).

5. Seleccione COMx: Bluetooth en el menú Port (Puerto).

6. Haga clic en OK (Aceptar).

7. Si se le pide un código PIN, introduzca el de la impresora (consulte la 
página 63) y, luego, haga clic en OK (Aceptar).
El ordenador HP Jornada establecerá conexión con la impresora y se imprimirá 
el archivo.

La tarjeta Bluetooth de AnyCom no es compatible con el HP Jornada 
700 series. Para imprimir mediante una conexión inalámbrica 
Bluetooth con un HP Jornada 700 series, utilice una tarjeta Bluetooth 
de Socket Communications.
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Compaq iPAQ Pocket PC
Compaq iPAQ H3870 admite la impresión inalámbrica Bluetooth. 

Compaq iPAQ H3870 

requisitos de impresión
Antes de imprimir, necesitará lo siguiente:

• Un iPAQ Pocket PC H3870
• Una aplicación de impresión de otro fabricante. Visite el sitio Web de 

productos FieldSoftware: www.fieldsoftware.com/PrintPocketCE.htm

http://www.fieldsoftware.com/PrintPocketCE.htm
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configuración e impresión
Siga estas instrucciones para configurar e imprimir con Compaq iPAQ:

1. Instale la aplicación de impresión de otro fabricante

2. Active el dispositivo de transmisión por ondas de radio Bluetooth de 
Compaq iPAQ.

3. Descubra la impresora.

4. Imprima un archivo.

instalación de la aplicación de impresión de otro fabricante
Compaq iPAQ requiere una aplicación de impresión de otro fabricante como, 
por ejemplo, PrintPocketCE. 

PrintPocketCE puede obtenerse en: www.fieldsoftware.com/PrintPocketCE.htm

Las instrucciones de los productos de otros fabricantes se proporcionan 
con fines informativos exclusivamente. HP no admite estos productos y 
no puede garantizar la precisión de las instrucciones. Póngase en 
contacto con el fabricante del producto si desea obtener información 
adicional.

http://www.fieldsoftware.com/PrintPocketCE.htm
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activación del dispositivo de transmisión por ondas de radio Bluetooth de 
Compaq iPAQ.

1. Haga clic en Start (Inicio) > Today (Hoy).

2. Haga clic en el icono Bluetooth de la parte inferior de la pantalla.

3. Haga clic en Turn radio On (Activar dispositivo de transmisión por 
ondas de radio).

descubrimiento de la impresora
Para que Compaq iPAQ pueda imprimir, debe descubrir antes la impresora 
(consulte descubrimiento de dispositivos Bluetooth en la página 62).

Siga estos pasos para descubrir la impresora:

1. Haga clic en Start (Inicio) > Today (Hoy).

2. Haga clic en el icono Bluetooth de la parte inferior derecha de la pantalla.

3. Haga clic en Bluetooth Manager (Gestor de Bluetooth).
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4. Haga clic en Yes (Sí) si desea buscar los dispositivos en este momento.
Compaq iPAQ buscará todos los dispositivos de tecnología Bluetooth que estén 
dentro del radio de alcance y mostrará el nombre de dispositivo Bluetooth 
(consulte la página 63) de todos los dispositivos que descubra.

5. Haga clic en la casilla de verificación que aparece junto al nombre del 
dispositivo Bluetooth de la impresora y, luego, en Save (Guardar).

Si hay más de dos impresoras hp deskjet 995c series dentro del radio 
de alcance, la pantalla que aparece arriba muestra todos los nombres 
de dispositivos Bluetooth de la impresora. 
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6. Haga clic en Home (Inicio) o Work (Trabajar) y, a continuación, en OK 
(Aceptar).

Volverá a aparecer la pantalla Bluetooth Manager (Gestor de Bluetooth). 

7. Haga clic en OK (Aceptar) en la parte superior derecha de la pantalla para 
cerrar Bluetooth Manager.

8. Haga clic en Tools (Herramientas)> Settings for All Devices (Configuración de 
todos los dispositivos).
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9. Haga clic en la ficha Serial Port (Puerto serie). Observe el valor del campo 
Outbound COM Port (Puerto COM de salida). Necesitará esta información 
cuando desee imprimir mediante aplicaciones de otros fabricantes. En el 
ejemplo que se muestra a continuación, el puerto COM de salida es COM8.

impresión de un archivo mediante e Compaq iPAQ 
aplicaciones de otros fabricantes

Las instrucciones de impresión del Compaq iPAQ pueden variar según la aplicación 
de impresión de otro fabricante que se utilice. Para ver las instrucciones de 
impresión, consulte la documentación que recibió junto con la aplicación de otro 
fabricante.

requisitos de impresión

Antes de poder imprimir, necesitará un software de impresión (consulte instalación 
de la aplicación de impresión de otro fabricante en la página 28), y tendrá que 
descubrimiento de la impresora (consulte la página 29).

Siga estos pasos para imprimir mediante una conexión inalámbrica:

1. Haga clic en Start (Inicio) > Today (Hoy).

2. Haga clic en Start > Programs (Inicio/Programas) y, a continuación, 
en PrintPocketCE.

3. Haga clic en el archivo de la lista que desea imprimir.
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4. Seleccione HP PCL en la lista de impresoras. 

5. Haga clic en la lista de Port (Puertos) y, a continuación, en el puerto de 
impresora (el puerto COM de salida) del paso 8 de la sección previa. También 
es posible modificar otras opciones de impresión de esta pantalla mediante un 
clic en More Settings (Más ajustes).

6. Haga clic en Start Printing (Comenzar impresión).

7. Cuando haya terminado, haga clic en otro archivo si desea imprimir más, 
o en Doc Options > Exit (Opciones de documento/Salir).
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dispositivo de bolsillo Palm m500 series
Palm m500 series admite la impresión inalámbrica Bluetooth.

Palm m500 series

requisitos
Antes de imprimir necesitará lo siguiente:

• Una tarjeta de expansión SDI/O (Secure Digital Input/Output) Bluetooth y su 
software. Visite la página Palm de 3Com en: www.palm.com.

• (Opcional) Documents To Go. Busque Documents To Go en el CD que recibió 
junto con su dispositivo de bolsillo Palm, o visite el sitio Web de DataViz: 
www.dataviz.com.

http://www.palm.com
http://www.dataviz.com
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configuración e impresión
Siga estos pasos para configurar e imprimir con un dispositivo de bolsillo 
Palm m500:

1. Instale una tarjeta de expansión Bluetooth SDI/O.

2. Imprima un archivo.
• Imprima documentos sin formato con las opciones Date Book, Address, To 

Do List y Memo Pad (Agenda, Direcciones, Tareas y Bloc notas) mediante 
Send file (Envío de archivo). 

• Imprima documentos con formato con las opciones Date Book, Address, To 
Do List, Memo Pad y Mail (Agenda, Direcciones, Tareas, Bloc notas y 
Correo) medinate BTPrint.

• Imprima documentos de MS Word y MS Excel, con Documents to Go.

instalación de una tarjeta de expansión SDI/O Bluetooth 
Advertencia Debe instalar los archivos de software antes de insertar la tarjeta 
Bluetooth en el dispositivo de bolsillo Palm. De no hacerlo, la tarjeta no funcionaría 
correctamente.

Siga estos pasos para instalar una tarjeta SDI/O Bluetooth:

1. Asegúrese de haber instalado el software de la tarjeta SDI/O Bluetooth en 
su ordenador.

2. Realice una operación HotSync.
Aparecerá un mensaje en el dispositivo Palm una vez que haya finalizado 
la sincronización HotSync.

3. Inserte la tarjeta SDI/O en la ranura de expansión.
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impresión de un archivo
Imprima un archivo con uno de los siguientes métodos:

• Envío de archivo 
• BtPrint 
• Documents To Go 

envío de archivo
El envío es un método de comunicación inalámbrica Bluetooth que forma parte 
de Palm OS 4,0. El documento se imprime sin formato.

Siga estos pasos para imprimir un documento:

1. Haga clic en el icono Home (Inicio) hasta que aparezca el menú Main Menu 
(Principal).

2. Haga clic en una de las siguientes opciones:
• Address (Dirección)
• Memo Pad (Bloc de notas)
• Date Book (Agenda)
• To Do List (Tareas)

Aparecerá la pantalla del programa seleccionado.

3. Seleccione el documento que desee imprimir.

4. Haga clic en el icono Menu (Menú).

5. Haga clic en Send (Enviar).
El dispositivo de bolsillo Palm buscará y mostrará en pantalla una lista de 
dispositivos Bluetooth disponibles.

6. Haga clic en la casilla de verificación que aparece junto al nombre del 
dispositivo Bluetooth de la impresora, y luego en OK (Aceptar).
Si se le pide un código PIN, introduzca el de la impresora y haga clic en OK 
(Aceptar). El código PIN predeterminado es 0. 

El dispositivo de bolsillo Palm establecerá conexión con la impresora y se 
imprimirá el archivo.
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BtPrint (opcional)
BtPrint mejora el formato de los documentos impresos con las opciones Address, 
Memo Pad, To Do List, Date Book y Mail (Direcciones, Bloc de notas, Tareas, 
Agenda y Correo).

instalación de BtPrint

Compruebe que el soporte del dispositivo de bolsillo Palm esté conectado al PC. 
Coloque el Palm en el soporte.

1. Haga clic en el icono Palm Desktop del ordenador.

2. Haga clic en View > Install > Add (Ver/Instalar/Añadir).

3. Vaya al CD o a la carpeta donde se encuentra el software SDI/O Bluetooth 
del dispositivo de bolsillo Palm.

4. Haga doble clic en la carpeta Printing (Impresión).

5. Haga doble clic en la carpeta HP.

6. Seleccione BtPrintVxxxxx.prc donde “xxxxx” indica la versión actual 
del programa.

7. Haga clic en Open > Done (Abrir/Hecho).

8. Realice una operación HotSync para instalar BtPrint en el dispositivo de 
bolsillo Palm.

9. Inserte la tarjeta SDI/O Bluetooth en el dispositivo de bolsillo Palm.

impresión con BtPrint

1. Haga clic en el icono Home (Inicio) hasta que aparezca el menú All (Todos).

2. Haga clic en el icono BtPrint995c.
Aparecerá la pantalla BtPrint.
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3. Haga clic en una de las siguientes opciones:
• Date Book (Agenda)
• Address (Dirección)
• To Do List (Tareas)
• Memo Pad (Bloc de notas)
• Mail (Correo)
Aparecerá la pantalla del programa seleccionado.

4. Seleccione la categoría o el archivo que desea imprimir.

5. Haga clic en el icono Menu (Menú).

6. Haga clic en BtPrint en el menú. Si está imprimiento To Do List (Lista de tareas), 
haga clic en Today Tomorrow o All (Hoy/Mañana/Todos) para seleccionar 
lo que desea imprimir.
Aparecerá la pantalla de configuración de BtPrint.

7. Seleccione las opciones adecuadas:
• Copies (Copias): número de páginas que se van a imprimir
• Paper Size (Tamaño de papel): tamaño de papel adecuado

8. Seleccione una de las siguientes opciones de impresión: 
• Si ha seleccionado una impresora como predeterminada, haga clic en OK 

(Aceptar) y vaya al paso 9. Para más información sobre la selección de 
una impresora como predeterminada, consulte en la página.

• Si desea seleccionar una impresora Bluetooth, haga clic en Select Printer 
(Seleccionar impresora). El dispositivo de bolsillo Palm buscará los 
dispositivos Bluetooth. Cuando aparezca la lista de dispositivos 
disponibles, vaya al paso 9.

9. Haga clic en la casilla de verificación que aparece junto al nombre del 
dispositivo Bluetooth de la impresora, y luego en OK (Aceptar).
Si se le pide un código PIN, introduzca el de la impresora y luego haga clic 
en OK (Aceptar). El código PIN predeterminado es 0. 

El dispositivo de bolsillo Palm establecerá conexión con la impresora y se 
imprimirá el archivo.

Si el comando BtPrint no aparece en el menú, BtPrint no es compatible 
con la categoría o vista seleccionadas.
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selección de una impresora como predeterminada (opcional)

Para seleccionar la impresora Bluetooth HP deskjet 995c como predeterminada:

1. Haga clic en BtPrint995c.

2. Haga clic en BTDiscover.
El dispositivo de bolsillo Palm buscará todos los dispositivos de tecnología 
inalámbrica Bluetooth que estén dentro de un radio de 9 metros.

3. Haga clic en Find More (Buscar más). 

4. Haga clic en HP deskjet 995c.

5. Haga clic en OK (Aceptar).



40

Documents To Go (opcional)
Documents To Go le permite imprimir archivos MS Word y MS Excel, y se incluye 
en el CD de instalación del dispositivo de bolsillo Palm, en la sección de software 
de obsequio.
instalación de Documents To Go

Instale Documents To Go desde el CD que recibió junto con su dispositivo de bolsillo 
Palm, o visite el sitio Web de DataViz: www.dataviz.com para obtener más 
información.
impresión con Documents To Go

1. Haga clic en el icono Home (Inicio) hasta que aparezca el menú All (Todos).
2. Haga clic en el icono BtPrint995c.
3. Haga clic en el icono DocToPrint.

Aparecerá la pantalla DocToPrint.
4. Haga clic en la flecha junto a Document Type (Tipo de documentos) para 

seleccionar el tipo de documento:
• All Types (Todos los tipos)
• DocFile (Archivo de documento)
• Sheet To Go (Hoja de cálculo To Go)
• Word To Go (Archivo Word To Go)

5. Seleccione el tipo de documento adecuado.
Aparecerá la pantalla correspondiente al tipo de documento seleccionado, 
que contiene una lista de archivos de aplicaciones que pueden imprimirse.

6. Seleccione un archivo y haga clic en Print (Imprimir).
7. Seleccione una de las siguientes opciones:

• Si ha seleccionado una impresora como predeterminada, haga clic en OK 
(Aceptar) y vaya al paso 9. Para más información sobre la selección de una 
impresora como predeterminada, consulte selección de una impresora como 
predeterminada.

• Si desea seleccionar una impresora Bluetooth, haga clic en Select Printer 
(Seleccionar impresora). El dispositivo de bolsillo Palm buscará los 
dispositivos Bluetooth. Cuando aparezca la lista de dispositivos disponibles, 
vaya al paso 8.

8. Haga clic en el nombre de dispositivo Bluetooth de la impresora y luego en OK 
(Aceptar).
Aparecerá la pantalla BtPrint.

9. Seleccione las opciones de impresión deseadas y luego puntee en OK (Aceptar) 
para imprimir el documento.
El dispositivo de bolsillo Palm establecerá conexión con la impresora y se 
imprimirá el archivo.

http://www.dataviz.com
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impresión desde otros dispositivos Bluetooth
Se están introduciendo en el mercado numerosos dispositivos de tecnología 
inalámbrica Bluetooth.

Este documento contiene instrucciones para los siguientes:

• teléfonos con tratamiento de imagen Nokia Series 60

Este documento se irá actualizando conforme vayan saliendo a la venta nuevos 
dispositivos.

teléfonos móviles

Puede que sea posible imprimir desde su teléfono móvil. Si desea obtener más 
información, consulte la documentación de usuario de su teléfono móvil. Si no se 
incluyera referencia alguna a la posibilidad de imprimir mediante el teléfono móvil, 
póngase en contacto directamente con el fabricante de su teléfono móvil.

Puede que sea necesario que descargue software adicional para que su teléfono 
permita la impresión.
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teléfonos con tratamiento de imagen 
Nokia Series 60
Algunos teléfonos móviles Nokia Series 60 con tratamiento de imagen admiten 
impresión con dispositivo móvil. Si desea obtener más información, consulte los 
siguientes sitios Web: 

• Europa y África: www.nokia.com
• América: www.nokiausa.com
• Pacífico asiático: www.nokia-asia.com

Si tiene dudas en cuanto a asistencia técnica referente a la configuración de su 
teléfono para imprimir, póngase en contacto directamente con el fabricante de 
su teléfono móvil.

Teléfonos con tratamiento de imagen Nokia Series 60

requisitos
Antes de imprimir necesitará lo siguiente:

• Un teléfono con tratamiento de imagen Nokia Series 60 compatible con 
la tecnología inalámbrica Bluetooth

• Una aplicación de impresión con dispositivo móvil para teléfonos con 
tratamiento de imagen Nokia Series 60 

configuración e impresión
Siga estas instrucciones para configurar e imprimir con un teléfono Nokia 60 Series:

1. Instale la aplicación de impresión con dispositivo móvil en el teléfono.

2. Imprima un archivo con uno de los siguientes métodos:
• Aplicación de impresión con dispositivo móvil 
• Envío con dispositivo Bluetooth 

http://www.nokia.com
http://www.nokiausa.com 
http://www.nokia-asia.com
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instalación de la aplicación de impresión con dispositivo móvil 
en el teléfono.
Siga estos pasos para instalar la aplicación de impresión con dispositivo móvil 
para teléfonos con tratamiento de imagen Nokia Series 60 en su teléfono:

1. Descargue la aplicación de impresión con dispositivo móvil para teléfonos con 
tratamiento de imagen Nokia Series 60 en un ordenador de uno de los siguientes 
sitios Web:
• Europa y África: www.nokia.com
• América: www.nokiausa.com
• Pacífico asiático: www.nokia-asia.com
El nombre del archivo descargado es print.sis.

2. Transfiera el archivo print.sis desde el ordenador al teléfono mediante uno 
de los siguientes métodos:

Si desea obtener ayuda al utilizar estos métodos de transferencia, consulte las 
instrucciones que aparecen en la guía de usuario del teléfono Nokia o visite el 
sitio Web de asistencia técnica de Nokia.

método de 
transferencia

instrucciones de transferencia

Correo electrónico Adjunte el archivo print.sis a un mensaje electrónico 
y envíelo a su dirección electrónica. A continuación, 
abra el mensaje desde su teléfono.

Bluetooth Utilice la utilidad Bluetooth de su ordenador para 
descubrir el teléfono y, a continuación, envíe el 
archivo print.sis desde su ordenador al teléfono.

Infrarrojos Alinee la lente de infrarrojos del teléfono con la del 
ordenador. Utilice la función Vínculo inalámbrico de 
Windows para enviar el archivo print.sis al teléfono.

http://www.nokia.com
http://www.nokiausa.com 
http://www.nokia-asia.com
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3. Dependiendo del método de transferencia que utilizó, abra el archivo print.sis:

4. Siga las instrucciones que aparecen en pantalla para instalar la aplicación.

5. Compruebe que se ha instalado la aplicación de impresión con dispositivo 
móvil. Pulse la tecla Menu  (Menú) para abrir el menú principal del teléfono. 
Desplácese por el menú y localice el icono Print (Imprimir).

En caso de que no viera el icono Print (Imprimir), repita los pasos de 3 a 5.

método de 
transferencia

instrucciones de apertura

Correo electrónico Vaya a Messaging > Inbox > Mailbox (Mensajes/
Buzón de entrada/Buzón de correo). Recupere el 
mensaje electrónico y, a continuación, seleccione 
Options > Attachments (Opciones/Archivos adjuntos) 
para abrir el archivo print.sis.

Bluetooth Vaya a Messaging > Inbox (Mensajes/Buzón de 
entrada) y, a continuación, seleccione el archivo 
print.sis.

Infrarrojos Vaya a Messaging > Inbox (Mensajes/Buzón de 
entrada) y, a continuación, seleccione el archivo 
print.sis.
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impresión de un archivo
Utilice uno de los siguientes métodos para imprimir un archivo:

• Aplicación de impresión con dispositivo móvil 
• Envío con dispositivo Bluetooth 

Aplicación de impresión con dispositivo móvil para teléfonos con tratamiento 
de imagen Nokia Series 60
A continuación se muestran las instrucciones para imprimir los siguientes tipos 
de archivo con una aplicación de impresión con dispositivo móvil:

• Imagen 
• Mensaje 
• Contacto 
• Agenda 
• Nota 

Antes de empezar, asegúrese de que la impresora está encendida e inactiva. 
Si la impresora está apagada u ocupada, su archivo no se imprimirá.
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impresión de una imagen

Siga estos pasos para imprimir una imagen:

1. Pulse la tecla Menu  (Menú) para abrir el menú principal del teléfono 
(Main menu).

2. Desplácese por él y seleccione el icono Print (Imprimir).

3. Seleccione Images (Imágenes).

4. Seleccione la imagen o imágenes que desea imprimir.
Las imágenes seleccionadas tienen una marca de verificación junto a ellas. 
No seleccione más de 20 imágenes en un solo trabajo de impresión.

5. Seleccione Options > Page Format (Opciones/Formato de página).

6. Seleccione la presentación de la imagen:
• 1 por página
• 2 por página
• 6 por página

7. Elija una de las siguientes opciones:

8. Seleccione Options > Print (Opciones/Imprimir) y, a continuación, elija una de 
las siguientes opciones:

si la presentación de la 
imagen es...

entonces...

1 por página Seleccione el tamaño de la imagen: Small, 
Medium o Large (Pequeño/Mediano/Grande).

2 ó 6 por página Vaya al paso 8.

si... entonces...

Se ha descubierto más de 
una impresora

Seleccione la impresora adecuada. Puede 
identificar la impresora por su nombre de 
dispositivo.

La impresora deseada no 
es descubierta

Seleccione Options > Find Printers (Opciones/
Encontrar impresoras) y, a continuación, 
seleccione la impresora.
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impresión de un mensaje

Los archivos recibidos con un tipo de archivo no reconocido deben guardarse con 
el tipo de archivo adecuado (.jpg o.txt, por ejemplo) antes de poder imprimirse.

Siga estos pasos para imprimir un mensaje:

1. Pulse la tecla Menu  (Menú) para abrir el menú principal del teléfono 
(Main menu).

2. Desplácese por él y seleccione el icono Print (Imprimir).

3. Seleccione Messaging (Mensajes).

4. Seleccione la carpeta que contiene el mensaje.

5. Desplácese por ella y seleccione el mensaje que desea imprimir.

6. Seleccione Options > Print (Opciones/Imprimir) y, a continuación, elija una de 
las siguientes opciones:

si... entonces...

Se ha descubierto más de 
una impresora

Seleccione la impresora adecuada. Puede 
identificar la impresora por su nombre de 
dispositivo.

La impresora deseada no 
es descubierta

Seleccione Options > Find Printers (Opciones/
Encontrar impresoras) y, a continuación, 
seleccione la impresora.
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impresión de un contacto

Siga estos pasos para imprimir un contacto:

1. Pulse la tecla Menu  (Menú) para abrir el menú principal del teléfono 
(Main menu).

2. Desplácese por él y seleccione el icono Print (Imprimir).

3. Seleccione Contacts (Contactos).
4. Haga clic en la casilla que aparece junto al contacto que desea imprimir.
5. Seleccione Options > Print (Opciones/Imprimir) y, a continuación, elija una de 

las siguientes opciones:

impresión de una agenda

Siga estos pasos para imprimir una agenda:

1. Pulse la tecla Menu  (Menú) para abrir el menú principal del teléfono 
(Main menu).

2. Desplácese por él y seleccione el icono Print (Imprimir).

3. Seleccione Calendar (Agenda).
4. Seleccione Options > Go To Date (Opciones/Ir a fecha) y, a continuación, 

introduzca la fecha deseada.
5. Seleccione Options > Print (Opciones/Imprimir) y, a continuación, elija una de 

las siguientes opciones:

si... entonces...

Se ha descubierto más de 
una impresora

Seleccione la impresora adecuada. Puede 
identificar la impresora por su nombre de 
dispositivo.

La impresora deseada no 
se ha descubierto

Seleccione Options > Find Printers (Opciones/
Encontrar impresoras) y, a continuación, 
seleccione la impresora.

si... entonces...

Se ha descubierto más de 
una impresora

Seleccione la impresora adecuada. Puede 
identificar la impresora por su nombre de 
dispositivo.

La impresora deseada no 
es descubierta

Seleccione Options > Find Printers (Opciones/
Encontrar impresoras) y, a continuación, 
seleccione la impresora.
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impresión de una nota

Siga estos pasos para imprimir una nota:

1. Pulse la tecla Menu  (Menú) para abrir el menú principal del teléfono 
(Main menu).

2. Desplácese por él y seleccione el icono Print (Imprimir).

3. Seleccione Notes (Notas).

4. Abra la nota que desea imprimir.

5. Seleccione Options > Print (Opciones/Imprimir) y, a continuación, elija una de 
las siguientes opciones:

si... entonces...

Se ha descubierto más de 
una impresora

Seleccione la impresora adecuada. Puede 
identificar la impresora por su nombre de 
dispositivo.

La impresora deseada no 
es descubierta

Seleccione Options > Find Printers (Opciones/
Encontrar impresoras) y, a continuación, 
seleccione la impresora.
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Envío con dispositivo Bluetooth
Bluetooth Send (Envío con dispositivo Bluetooth) es una función que incluye su 
teléfono móvil. No es una aplicación creada por HP.

Bluetooth Send (Envío con dispositivo Bluetooth) imprime texto e imágenes sin 
formato. Por ejemplo, sólo permite imprimir un elemento de agenda y no un día 
completo. Para imprimir texto e imágenes con formato, utilice Mobile Printing 
Application (Aplicación de impresión con dispositivo móvil).

Antes de empezar, asegúrese de que la impresora está encendida e inactiva. 
Si la impresora está apagada u ocupada, su archivo no se imprimirá.

Siga estos pasos para imprimir un archivo con Bluetooth Send:

1. Pulse la tecla Menu  (Menú) para abrir el menú principal del teléfono 
(Main menu).

2. Desplácese por él y seleccione una de las siguientes opciones:
• Contacts (Contactos)
• Calendar (Agenda)
• Images (Imágenes)
• To Do List (Lista de tareas)
• Extras > Notes (Extras/Notas)
Aparecerá la pantalla de la opción seleccionada.

3. Seleccione el archivo que desea imprimir.
El método de selección del archivo varía en función del tipo de archivo. 
Consulte la guía de usuario del teléfono si desea obtener más información.

4. Seleccione Options (Opciones).

5. Seleccione Send (Enviar) y, a continuación, Via Bluetooth (Mediante dispositivo 
Bluetooth).

6. Seleccione la impresora adecuada.
Puede identificar la impresora por su nombre de dispositivo.



51

resolución de problemas
Esta sección trata únicamente sobre la impresión inalámbrica Bluetooth. Para más 
información sobre la resolución de problemas, haga clic en asistencia rápida en la 
pantalla del asistente de la impresora HP.

Seleccione el tema que mejor describe el problema que está experimentando:

impresora
• El LED de Bluetooth parpadea o está apagado
• la impresora no se puede descubrir
• la impresora se descubre pero no imprime

ordenadores de escritorio y portátiles
• se ha descubierto más de una impresora hp deskjet 995c
• tras la instalación HCRP, el icono de la impresora no aparece en la lista 

My Printers (Mis impresoras) 
• aparece un mensaje de error al imprimir a un archivo
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resolución de problemas de la impresora

El LED de Bluetooth parpadea o está apagado

Esta tabla explica el comportamiento del LED de Bluetooth:

el LED de 
Bluetooth está...

esto significa que... acción

Parpadeando La impresora puede estar 
recibiendo datos a través 
de una conexión 
inalámbrica Bluetooth. 
Cuando la impresora está 
ocupada, los demás 
dispositivos no pueden 
descubrirla.

Espere hasta que la luz deje 
de parpadear antes de 
intentar descubrir la 
impresora.

La impresora puede estar 
configurada temporalmente 
en modo público.

Intente descubrir la impresora 
o establecer comunicación 
con ella. Si no puede 
descubrir la impresora, 
espere hasta que la luz deje 
de parpadear.

Parpadeando 
junto con la luz 
de reanudación 
durante 5 
segundos

Se ha producido un error 
temporal de la conexión de 
Bluetooth y ésta ha sido 
suspendida.

Intente descubrir la impresora 
de nuevo. Si el error persiste, 
cambie la posición del 
dispositivo emisor o de la 
impresora y vuelva a 
descubrir la impresora.

Parpadeando 
junto con la luz 
de reanudación 
durante más de 
5 segundos

Se ha producido un error 
interno de la impresora 
como, por ejemplo, un 
atasco de papel.

Pulse el botón Resume 
(Reanudar), compruebe la 
carga de papel y vuelva a 
descubrir la impresora.

Off 
(Desactivado)

Es posible que la impresora 
esté en modo privado o que 
su dispositivo Bluetooth esté 
desactivado.

Mantenga pulsado el botón 
de encendido durante 3 
segundos. Si la luz parpadea, 
intente descubrir la 
impresora.

Puede que el cable de 
alimentación eléctrica de 
la impresora no esté 
enchufado.

Asegúrese de que el cable de 
alimentación eléctrica de la 
impresora está enchufado.
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la impresora no se puede descubrir
Compruebe que:

• El cable de alimentación de la impresora está enchufado
• El LED de Bluetooth está encendido
• El LED de Bluetooth no está parpadeando

Si se cumplen todas las condiciones anteriores, intente descubrir la impresora 
de nuevo. Si no lo consigue, pruebe colocando el dispositivo emisor más cerca de la 
impresora.

Si el LED de Bluetooth está apagado o parpadea, consulte El LED de Bluetooth 
parpadea o está apagado en la página 52.

la impresora se descubre pero no imprime

Si la impresora no imprime, compruebe que:

• Hay papel en la impresora
• Los cartuchos de tinta no están vacíos
• No hay ningún atasco de papel en la impresora

Para obtener más información, consulte asistencia rápida en la pantalla del asistente 
de la impresora HP.

Si la impresora no imprime pero no aparece ningún error, compruebe que:

• El LED de Bluetooth está encendido
• El LED de Bluetooth no está parpadeando

Si el LED de Bluetooth está apagado o parpadea, consulte El LED de Bluetooth 
parpadea o está apagado en la página 52.

Si el LED de Bluetooth está encendido y permanece fijo, haga lo siguiente:

1. Pulse el botón de encendido para apagar la impresora.

2. Desconecte el cable de alimentación de la impresora.

3. Vuelva a conectar el cable de alimentación de la impresora.

4. Pulse el botón de encendido para encender la impresora.

5. Intente imprimir el documento de nuevo.

Si la impresora sigue sin imprimir, mantenga pulsado el botón Cancel (X) (Cancelar) 
durante 4 segundos para imprimir una página de configuración de Bluetooth. 
Si la dirección del dispositivo Bluetooth consta de ceros o muestra el mensaje Radio 
Module Not Found (No se encuentra ningún módulo de transmisión radio), llame a 
la asistencia técnica de HP.
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resolución de problemas de conexión al ordenador

se ha descubierto más de una impresora hp deskjet 995c

Si hay dos o más impresoras hp deskjet 995c series dentro del radio de alcance, 
el dispositivo emisor mostrará tantos iconos como impresoras hp deskjet 995c haya.

Cada icono mostrará el nombre de dispositivo Bluetooth de la impresora 
(consulte la página 63). 

Para encontrar el nombre de dispositivo Bluetooth de una impresora específica:

1. Para imprimir una página de configuración de Bluetooth, mantenga pulsado 
el botón Cancel (X) (Cancelar) durante 4 segundos. 

2. Seleccione el icono correspondiente al nombre del dispositivo Bluetooth que 
aparece en la página de configuración.
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tras la instalación HCRP, el icono de la impresora no aparece en la lista 
My Printers (Mis impresoras)

Puede que la configuración de la codificación de la impresora sea incorrecta si no 
aparece el icono de la impresora en la lista My Printers (Mis impresoras) tras haber:

• Instalado el software de la impresora
• Ejecutado el Bluetooth Connection Wizard (Asistente para conexión Bluetooth) 

para establecer una conexión HCRP en la impresora

Siga estos pasos para corregir la configuración de la codificación de la impresora:

1. Para imprimir una página de configuración de Bluetooth, mantenga pulsado 
el botón Cancel (X) (Cancelar) durante 4 segundos.

2. Localice elelemento de línea de Encryption Required (Codificación) en la 
página de configuración de Bluetooth:

si en la línea de codificación se lee... entonces...

Encryption = 0 (Codificación = 0 )
Encryption Off (Codificación 
desactivada)

La impresora no requiere 
codificación.

Encryption = 1 (Codificación = 1)
Encryption On (Codificación 
activada)

La impresora requiere 
codificación.
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3. Haga clic en Start (Inicio) > Control Panel (Panel de control) y, a continuación, 
elija una de las siguientes opciones:

4. Haga clic en la ficha Bluetooth.

5. Seleccione la impresora en la lista Devices (Dispositivos) y, a continuación, 
haga clic en Remove (Quitar).

Category View (Vista de categoría) Classic View (Vista clásica)

Haga doble clic en el icono Wireless 
Link (Vínculo inalámbrico).

Haga clic en Printers and other 
Hardware (Impresoras y otro 
hardware) y, a continuación, 
haga clic en el icono Wireless Link 
(Vínculo inalámbrico).
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6. Siga las instrucciones que empiezan en el paso 4 de la página 11.
En la pantalla Authenticate the device? (¿Autenticar el dispositivo?), elija una de 
las siguientes opciones:

si en la línea de codificación se lee... entonces...

Encryption = 0 (Codificación = 0 )
Encryption Off (Codificación 
desactivada)

Haga clic en No y, a continuación, 
en Next (Siguiente).

Encryption = 1 (Codificación = 1)
Encryption On (Codificación 
activada)

Haga clic en Yes (Sí) y, a continuación, 
en Next (Siguiente). 
Se le solicitará el código PIN de la 
impresora. Introduzca el código PIN.

También puede restablecer los valores predeterminados de fábrica 
de la impresora, en los que la codificación y la autenticación están 
desactivadas.
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aparece un mensaje de error al imprimir a un archivo
1. Haga clic en Cancel (Cancelar) en el mensaje de error Print to File 

(Imprimir a un archivo) y, a continuación, cierre todas las aplicaciones.

2. Vuelva a abrir una aplicación e imprima un documento.

Si el problema persiste, siga estos pasos para determinar el número del 
puerto COM:

1. Haga clic en Cancel (Cancelar) del mensaje de error al imprimir a un archivo 
y cierre la aplicación.

2. Haga clic en Start > Programs > 3Com Mobile > Bluetooth Connection Manager 
(Inicio/Programas/Dispositivo móvil 3Com/Bluetooth Connection Manager)
Se abrirá Bluetooth Connection Manager.

3. Haga clic en Tools (Herramientas) > Com Port (Puerto Com).
Aparecerá el cuadro de diálogo Bluetooth COM Ports (Puertos COM 
de Bluetooth).

4. Anote el número del puerto COM de cliente Bluetooth de 3Com.
Por ejemplo, en el ejemplo anterior el puerto de cliente Bluetooth de 
3Com es COM4.

5. Haga clic en Close (Cerrar) para cerrar el cuadro de diálogo Bluetooth 
COM Ports (Puertos COM de Bluetooth).

Siga estos pasos para seleccionar la impresora adecuada y el puerto inalámbrico 
Bluetooth:

1. Haga clic en Start > Settings > Printers (Inicio/Configuración/Impresoras).

2. Haga clic en el icono de la impresora hp deskjet 995c series.

3. Haga clic en File > Properties (Archivo/Propiedades).

4. Haga clic en la ficha Ports (Puertos)

5. Seleccione el puerto inalámbrico Bluetooth, haga clic en Apply (Aplicar) 
y luego en OK (Aceptar).

6. Abra una aplicación e imprima un documento.



59

Si el problema persiste, siga estos pasos:

1. Haga clic en Cancel (Cancelar) del mensaje de error al imprimir a un archivo 
y cierre la aplicación.

2. Haga clic en Start > Programs > Hewlett-Packard > hp deskjet 995c series > 
hp deskjet 995c series Uninstall (Inicio/Programas/Hewlett-Packard/
hp deskjet 995c series/ Desinstalación de hp deskjet 995c series)

3. Siga las instrucciones que aparecen en pantalla.

4. Inserte el CD con el software de la impresora en la unidad de CD-ROM del 
ordenador y vuelva a instalar el software de la impresora.
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acerca del dispositivo inalámbrico Bluetooth de 
la impresora
Para obtener información acerca del dispositivo inalámbrico Bluetooth de la 
impresora, seleccione el tema adecuado:

• dispositivo inalámbrico Bluetooth de la impresora
• cambio del dispositivo inalámbrico de la impresora
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dispositivo inalámbrico Bluetooth de la 
impresora
En esta sección se explican algunos elementos básicos del dispositivo inalámbrico 
Bluetooth de la impresora.

conceptos básicos del dispositivo inalámbrico Bluetooth

diez metros o menos
La tecnología inalámbrica Bluetooth permite que los dispositivos, tales como 
impresoras y ordenadores portátiles, se comuniquen a distancias cortas (10 m o 
menos) mediante ondas de radio en la gama de 2,4 GHz.

Para poder utilizar la tecnología Bluetooth, el dispositivo debe tener instalado un 
módulo inalámbrico Bluetooth de transmisión por ondas de radio. La impresora 
hp deskjet 995c series cuenta con un módulo interno. 

Al contrario que la comunicación por infrarrojos, la tecnología inalámbrica 
Bluetooth no requiere que el dispositivo emisor esté situado directamente delante 
del dispositivo receptor.

un dispositivo cada vez
La impresora puede establecer una conexión inalámbrica Bluetooth con un solo 
dispositivo cada vez.

El LED Bluetooth parpadea cuando la impresora está ocupada con una conexión 
inalámbrica Bluetooth. La impresora hará caso omiso de cualquier otro dispositivo 
que intente establecer una conexión y éste deberá esperar hasta que se cierre la 
conexión original antes de establecer una nueva.

10 m o menos
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descubrimiento de dispositivos Bluetooth 
El descubrimiento es el proceso mediante el cual un dispositivo con la tecnología 
inalámbrica Bluetooth detecta otros dispositivos con la tecnología Bluetooth dentro 
del radio de alcance.

Cuando un dispositivo descubre una impresora, muestra su nombre de dispositivo 
Bluetooth (consulte la página 63).

El método de descubrimiento varía según el tipo de software Bluetooth utilizado.

página de configuración de Bluetooth 
La página de configuración de Bluetooth muestra la información que necesitará 
cuando utilice la impresora.

Para imprimir una página de configuración de Bluetooth, mantenga pulsado el 
botón Cancelar (X) durante 4 segundos.

información de Bluetooth específica de la impresora
Todas las impresoras hp deskjet 995c series tienen los siguientes elementos que son 
específicos de cada una de ellas:

• nombre de dispositivo Bluetooth
• dirección del dispositivo Bluetooth
• código PIN

Para ver la información de Bluetooth de su impresora, imprima una página de 
configuración de Bluetooth (consulte la página 62).
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nombre de dispositivo Bluetooth
Cuando un dispositivo descubre una impresora, muestra su nombre de dispositivo 
Bluetooth. 

El nombre de dispositivo Bluetooth predeterminado de la impresora es: 
hp deskjet 995/[número de serie]. 

Puede cambiar el nombre del dispositivo Bluetooth de la impresora mediante el 
cuadro de diálogo Configure Wireless Settings (Configurar ajustes del dispositivo 
inalámbrico). Consulte cambio de la configuración de la impresión inalámbrica 
en la página 67.

dirección del dispositivo Bluetooth

Los dispositivos Bluetooth intercambian sus direcciones de dispositivos Bluetooth 
cuando interactúan. El usuario no puede cambiar la dirección del dispositivo 
Bluetooth de la impresora.

código PIN

Cuando la opción codificación (Codificación) está activada en la impresora 
(consulte la página 64), se solicitará un código PIN a todos los dispositivos 
que intenten utilizar dicha impresora.

El código PIN predeterminado es 0. Puede cambiar el código PIN mediante el 
cuadro de diálogo Configure Wireless Settings (Configurar ajustes del dispositivo 
inalámbrico). Consulte cambio de la configuración de la impresión inalámbrica 
en la página 67.

modos de acceso
Los modos de acceso determinan el nivel de acceso que tienen los dispositivos 
de tecnología inalámbrica Bluetooth en la impresora.

La impresora cuenta con cuatro modos de acceso:

• public mode (modo público)
• private mode (modo privado)
• turn off Bluetooth (Bluetooth apagado)
• encryption required (codificación)

Para establecer el modo de acceso a la impresora, utilice el cuadro de diálogo 
Configure Wireless Settings (Configurar ajustes del dispositivo inalámbrico). 
Consulte cambio de la configuración de la impresión inalámbrica en la página 67.

El nombre de dispositivo Bluetooth de la impresora sólo se muestra en 
aplicaciones Bluetooth, En la carpeta Printers (Impresoras), la impresora 
se identifica como hp deskjet 995c series.
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modo público
Cuando la impresora está configurada en modo público:

• Cualquier dispositivo de tecnología Bluetooth que se encuentre dentro del 
radio de alcance de 10 m puede descubrir la impresora.

• El LED de Bluetooth está encendido.

modo privado

Cuando la impresora está configurada en modo privado:

• Sólo aquellos dispositivos que tengan almacenada la dirección de dispositivo 
Bluetooth en su memoria pueden descubrir la impresora.

• Cuando la impresora esta inactiva, el LED de Bluetooth está apagado.
• Puede colocar la impresora en modo público temporalmente pulsando y 

manteniendo pulsado el botón de encendido hasta que el LED de Bluetooth 
empiece a parpadear. La impresora regresará al modo privado después 
de 1 minuto.

Bluetooth apagado

Cuando el dispositivo Bluetooth de la impresora está apagado:

• Otros dispositivos de tecnología Bluetooth no pueden descubrir la impresora.
• Cuando la impresora esta inactiva, el LED de Bluetooth está apagado.
• Puede colocar la impresora en modo Público temporalmente pulsando y 

manteniendo pulsado el botón de encendido hasta que el LED de Bluetooth 
empiece a parpadear. La impresora regresará al modo privado después 
de 1 minuto.

codificación

La impresora puede configurarse para que requiera codificación cuando 
reciba datos a través de una conexión inalámbrica Bluetooth. 

Cuando la opción Ecryption Required (Codificación) está seleccionada, 
para utilizar la impresora es preciso que:

• Todos los datos enviados a través de una conexión inalámbrica Bluetooth 
se encripten.

• Todos los usuarios introduzcan un código PIN la primera vez que impriman.
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autenticación
La autenticación proporciona un método de verificación de un dispositivo Bluetooth. 
Cuando se selecciona Encryption Required (Codificación), la autenticación se activa 
de forma automática en el cuadro de diálogo Configure Wireless Settings 
(Configurar ajustes del dispositivo inalámbrico).

establecer comunicación
Cuando una impresora y un dispositivo emisor establecen comunicación, 
cada uno almacena la dirección de dispositivo Bluetooth del otro.

Esto permite que el dispositivo descubra la impresora en modo privado 
(consulte la página 64)

límite de 32

La impresora sólo puede establecer comunicación con 32 dispositivos a la vez. 

Si la impresora ha establecido comunicación con 32 dispositivos y se quiere 
añadir otro, será necesario borrar de la memoria de la impresora todos los 
dispositivos anteriores. 

En la sección restablecimiento del acceso al dispositivo en la página 71, 
encontrará instrucciones sobre cómo eliminar de la memoria de la impresora 
aquellos dispositivos que ya han establecido comunicación anteriormente.

lista de dispositivos que han establecido comunicación

Para obtener una lista de los dispositivos que han establecido comunicación 
con la impresora, imprima una página de configuración de Bluetooth 
(consulte la página 62).

Todos los dispositivos deben enviar un código PIN la primera vez 
que imprimen cuando se ha seleccionado Encryption Required 
(Codificación).
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cambio del dispositivo inalámbrico de la 
impresora

cable USB y controlador de impresora necesarios
Para poder cambiar la configuración de impresión inalámbrica de la impresora, 
debe disponer de lo siguiente:

• Un ordenador conectado a la impresora mediante un cable USB
• Un controlador de impresora instalado para imprimir a través de un puerto USB

No se requiere ningún cable USB para imprimir con dispositivos Bluetooth.

instalación de controlador USB
Siga estos pasos para instalar un controlador de impresora USB:

1. Inserte el CD con el software de la impresora en la unidad de CD-ROM 
del ordenador.

2. Siga las instrucciones que aparecen en pantalla.

Siga estos pasos para comprobar que se haya instalado el controlador de 
impresora USB:

1. Haga clic en Start > Settings > Printers (Inicio/Configuración/Impresoras).
Aparecerá la ventana Impresoras.

2. Compruebe que aparezcan las dos versiones del controlador de impresora. 
Una de ellas está configurada para la impresión inalámbrica Bluetooth, 
mientras que la otra versión, hp deskjet 995c series (Copia 2), lo está para 
el puerto USB.
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cambio de la configuración de la impresión inalámbrica
Para poder cambiar la configuración de la impresión inalámbrica de la impresora, 
debe conectar ésta al ordenador mediante un cable USB.

1. Haga clic en Start>Programs>Hewlett-Packard>hp deskjet 995c series>hp deskjet 
995c series Toolbox (Inicio > Programas > Hewlett-Packard > hp deskjet 995c 
series > Caja de herramientas de la hp deskjet 995c series).
Aparecerá la caja de herramientas de HP.

2. En el menú desplegable, seleccione el controlador de la impresora 
hp deskjet 995c series. 
El controlador correcto empieza con USB.

1. Seleccione el controlador de la impresora hp deskjet 995c series

�
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3. Haga clic en la ficha Configuration (Configuración).
Aparece el panel de configuración.

4. Haga clic en Wireless (Inalámbrico) y luego en Configure Wireless Settings 
(Configurar ajustes del dispositivo inalámbrico).
Aparece el botón Configure Wireless Setting (Configurar ajustes del dispositivo 
inalámbrico). Si el botón no está activo, haga clic en la ficha Device Services 
(Servicios de dispositivo) y repita los pasos de 2 a 4.

5. Haga clic en el botón Configure Wireless Settings.
Aparece el cuadro de diálogo Configure Wireless Settings (Configurar ajustes 
del dispositivo inalámbrico). 
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6. Seleccione las opciones de dispositivo inalámbrico Bluetooth que desee.
Para obtener una descripción del cuadro de diálogo Configure 
Wireless Setting (Configurar ajustes del dispositivo inalámbrico), 
consulte cuadro de diálogo configure wireless settings.

7. Una vez haya seleccionado las opciones deseadas, haga clic en OK (Aceptar).
Aparece un cuadro de diálogo de advertencia.

8. Haga clic en OK (Aceptar) para cerrar el cuadro de diálogo de advertencia.
9. En la caja de herramientas, haga clic en la ficha Device Services (Servicios 

de dispositivos) y seleccione el controlador Bluetooth para la impresora 
hp deskjet 995c series en el menú desplegable.

10. Cierre la caja de herramientas y desconecte el cable USB de la impresora 
y del ordenador.

cuadro de diálogo configure wireless settings 
Utilice el cuadro de diálogo Configure Wireless Settings (Configurar ajustes del 
dispositivo inalámbrico) para establecer las siguientes opciones:

1. Device Address (Dirección del dispositivo): Dirección utilizada por los 
dispositivos Bluetooth para identificar la impresora.

2. Printer Name (Nombre de la impresora): Utilice para cambio de nombre 
del dispositivo Bluetooth de la impresora (consulte la página 70).

3. Change PIN Code (Cambiar el código PIN): Haga clic para cambio del 
código PIN de la impresora (consulte la página 70). Si se establece 
un código PIN y se selecciona Encryption Required (Codificación), 
se activa la autenticación. Consulte codificación y autenticación en 
página 64.

�
�
�
�

�



70

4. Reset Device Access (Restablecer acceso de dispositivos): Haga clic 
para restablecimiento del acceso al dispositivo (consulte la página 71) 
en la memoria de la impresora.

5. Mode (Modo): Permite establecer las siguientes opciones:
• Private mode (Modo privado): La impresora sólo puede ser descubierta 

por aquellos dispositivos que tengan su dirección almacenada en 
memoria. Consulte modo privado en la página 64.

• Public mode (Modo público): Todos los dispositivos de tecnología 
Bluetooth pueden descubrir la impresora. Consulte modo público en 
la página 64.

• Turn off Bluetooth (Bluetooth apagado): Desactiva la impresión 
inalámbrica Bluetooth.

• Encryption Required (Codificación): Cuando se selecciona la casilla de 
verificación Encryption Required (Codificación), se encriptan todos los 
datos enviados a la impresora. Esta opción también establece la 
autenticación de forma automática. Consulte codificación y autenticación 
en página 64.

cambio de nombre del dispositivo Bluetooth de la impresora

Cuando un dispositivo Bluetooth (por ejemplo, un ordenador portátil) descubre la 
impresora, identifica la impresora al usuario mediante su nombre de dispositivo 
Bluetooth.

La impresora sale de fábrica con un nombre predeterminado. Para poder cambiar el 
nombre de la impresora, debe conectarla al ordenador mediante un cable USB.

Para cambiar el nombre de la impresora:

1. Abra Toolbox (Caja de herramientas) y, a continuación, abra el cuadro de diálogo 
Configure Wireless Settings (Configurar ajustes del dispositivo inalámbrico).

2. Introduzca el nuevo nombre de la impresora (un máximo de 60 caracteres) en 
el cuadro Printer Name (Nombre de la impresora).

3. Haga clic en OK (Aceptar).
Cambiará el nombre de dispositivo Bluetooth de la impresora.

cambio del código PIN de la impresora 
Cuando la casilla Encryption Required (Codificación) está seleccionada, se solicitará 
un código PIN a todos los dispositivos que intenten utilizar dicha impresora.

Para restablecer el nombre de dispositivo Bluetooth predeterminado de 
la impresora, siga los pasos arriba descritos y deje el cuadro Printer 
Name (Nombre de la impresora) en blanco.
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Para poder cambiar el código PIN de la impresora, debe conectarla al ordenador 
mediante un cable USB. Siga estos pasos para establecer el código PIN:

1. Asegúrese de que la impresora está conectada al ordenador mediante un 
cable USB.

2. Abra Toolbox (Caja de herramientas) y luego el cuadro de diálogo Configure 
Wireless Settings (Configurar ajustes del dispositivo inalámbrico).

3. Haga clic en el botón Change PIN Code (Cambiar código PIN).
Aparece el cuadro de diálogo Change PIN Code (Cambiar código PIN).

4. Introduzca el nuevo código PIN.
El código PIN predeterminado es 0.

5. Vuelva a introducir el nuevo código PIN.
6. Haga clic en OK (Aceptar).

Ha cambiado el código PIN.

restablecimiento del acceso al dispositivo
Para poder cambiar la configuración de la impresión inalámbrica de la impresora, 
debe conectar ésta al ordenador mediante un cable USB. Siga estos pasos para 
borrar de la memoria de la impresora todos los dispositivos que han establecido 
comunicación.
1. Abra Toolbox (Caja de herramientas) y, luego, el cuadro de diálogo Configure 

Wireless Settings (Configurar ajustes del dispositivo inalámbrico).
2. Haga clic en el botón Reset Device Access (Restablecer acceso de dispositivos).

Aparece un cuadro de diálogo de advertencia.
3. Haga clic en OK (Aceptar) para cerrar el cuadro de diálogo de advertencia.

Todos los dispositivos que han establecido comunicación serán borrados de 
la memoria de la impresora.

restablecimiento de valores predeterminados de fábrica
Siga estos pasos para restablecer los predeterminados de fábrica de la impresora:
1. Mantenga pulsado el botón de encendido.
2. Mientras mantiene pulsado el botón de encendido, pulse el botón Cancel (X) 

(Cancelar) cuatro veces y, a continuación, el botón Resume (Reanudar) 
otras cuatro. 

3. Suelte el botón de encendido.
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